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Legal Disclaimer
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All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, which speak only as of their dates, and they should not be relied upon in making purchasing decisions.
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[bookmark: _Toc516648434][bookmark: _Toc11147450][bookmark: _Toc107319749]Release Notes
This document contains shared release notes and planned changes. Shared release notes and planned changes document features and changes that apply to SAP Concur solutions site-wide or to multiple SAP Concur products and services. They include but are not limited to:
· Security-related features and changes such as annual security certificate renewals and changes in support for security ciphers and protocols
· Site-wide UI features and changes such as changes to the home page, changes to the site header or footer, or the implementation of new site-wide UI themes
· Sign-in process features and changes such as the addition or removal of sign-in features, URL changes, and domain name changes
· Production and test environment features and changes
· Global settings or administration page features and changes such as the addition of new site-wide settings or changes to the design of the administration pages
· Changes to processes such as where and when release notes are published
For New Features and Changes that apply to a single product and/or service see the release notes for that product or service. Links to the product and service-specific release notes can be found on the following pages:
Professional Edition
Standard Edition
Small Business Edition

[bookmark: _Toc107319750]Concur Open
[bookmark: _Toc107319751]Japanese Translation Available (Jun 2)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	May 13, 2022
	June 10, 2022
	June 2, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319752]All Products | Professional & Standard
Overview
As of June 2, 2022, the ability to switch between English and Japanese has been added to the SAP Concur Open and SAP Personalized Concur Open pages.
[bookmark: _Hlk103170773]In addition, you can set English or Japanese as your preferred language on the Set Notification Preferences page.
Business Purpose / Client Benefit
This change eliminates the manual translation process and improves the customer experience.
End-User Experience
When an end user navigates to the SAP Concur Open page by clicking the link to Service Status in the concursolutions.com page footer, a new language icon is available to the left of the SAP logo in the upper right corner of the SAP Concur Open page. 
[image: ]
The new icon also appears on the SAP Personalized Concur Open page.
[image: ]
When the user clicks on the icon, they can choose to set the page language to either English or Japanese.
[image: ]
In addition, on the SAP Personalized Concur Open page, after clicking Subscribe to Notifications, they can set their preferred notification language to English or Japanese.
[image: ]
Configuration / Feature Activation
This change occurred automatically.
[bookmark: _Toc107319753]File Transfer Updates
[bookmark: _Toc93580783][bookmark: _Toc107319754]**Ongoing** Rotating PGP Key for File Transfers

	[bookmark: _Hlk92987153]Information First Published
	Information Last Modified
	Feature Target Release Date

	February 2021
	June 10, 2022
	January 15, 2021 and October 11, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93580784][bookmark: _Toc107319755]Travel, Expense, Invoice, Request, Intelligence | Professional & Standard
Overview
Files transferred to SAP Concur products must be encrypted with the SAP Concur public PGP key, concursolutionsrotate.asc. 
IMPORTANT!

Upcoming PGP key changes:

• The legacy (non-rotating) key, key ID D4D727C0, will be deprecated on October 11, 2022.

• The current rotating key, key ID 40AC5D35, will expire on September 4, 2022. 

• A new rotating key, key ID 9AFF10B5, is available in the client's root folder.
New rotating PGP key details:
· Key ID: 9AFF10B5
· Filename: concursolutionsrotate.asc
The filename for the rotating PGP key does not change when the key is rotated.
· As of June 4, 2022, the new rotating public PGP key is available in the client’s root folder. 
· RSA 4096-bit signing and encryption subkey.
· This key expires on September 4, 2024.
· Clients are responsible for replacing the rotating key before it expires.
· A new key will be provided 90 days before the September 4, 2024 expiration date.
Expiring rotating PGP key details:
· Key ID: 40AC5D35
· Filename: concursolutionsrotate.asc
· This key will expire on September 4, 2022.
Legacy (non-rotating) PGP key details:
· Key ID: D4D727C0
· The SAP Concur legacy (non-rotating) PGP key will be deprecated on October 11, 2022. 
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
· AWS transfer endpoints (when they are communicated to you)
Business Purpose / Client Benefit
The rotating public PGP key provides greater security for file transfers.
Admin Experience
An administrator with the required file transfer credentials can log into the file transfer site to retrieve the rotating public PGP key, concursolutionsrotate.asc, from the root directory.
Configuration / Feature Activation
Your internal file transfer administrator can add the new rotating key to their PGP keyring and start using it to encrypt files being transferred to SAP Concur any time prior to September 4, 2022. 
If you require assistance, please contact SAP Concur support.
For more information, refer to the Shared: File Transfer for Customers and Vendors User Guide.
[bookmark: _Toc107319756]Home Page
[bookmark: _Toc107319757]**Ongoing ** SAP Concur Homepage Changes

	Information First Published
	Information Last Modified
	Feature Target Release Date

	December 4, 2020
	May 13, 2022
	Q4 2021 – Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319758]All Products | All Editions
Overview
[bookmark: _Hlk19876476][bookmark: _Hlk19876428]In Q4, 2021, SAP Concur began redirecting clients to a new homepage. The appearance of the new homepage is identical to the previous SAP Concur homepage. The new homepage has enhanced functionality when services become temporarily unavailable.
The roll out of the new homepage is phased:
Phase 1: In October of 2021, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the US Datacenter to the new homepage. 
Phase 2: In December 2021, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the EU Datacenter to the new homepage.
Phase 3: At a date to be determined, SAP Concur will begin redirecting the remaining clients in the US and EU datacenters to the new homepage. The remaining clients include those with Concur Travel standalone or Concur Travel with Expense, Invoice, and/or Request.
Business Purpose / Client Benefit
This change ensures that the SAP Concur homepage is available even when some services are unavailable and improves the consistency of the sign in experience.
End-User Experience
With the old homepage, when a user signs into their SAP Concur products, they see their homepage.
The appearance of the homepage varies depending on which products and services are enabled for the client and the permissions assigned to the user.

If some products or services are unavailable while other products and services are up and running, a modified version of the user’s homepage similar to the following appears: 
[image: ]
After a client is migrated to the new homepage, if one or more services are unavailable, when a user signs in to their SAP Concur products, they will see the usual homepage, but if the user navigates to a page for a service that is unavailable, they will see a page similar to the following:
[image: ]
After migration to the new homepage, if all services are available, this change is transparent to the user and they see a homepage that is identical to the pre-migration homepage.
Example Homepage

Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc107319759]Localization
[bookmark: _Toc40271596][bookmark: _Toc107319760]Support for New Language (Ukrainian)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 10, 2022
	--
	June 18, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319761]All Products | Professional & Standard
Overview
With this release, SAP Concur now supports the following language:
· Ukrainian
Business Purpose / Client Benefit
This change enables users to configure the SAP Concur solutions UI text to display in Ukrainian.
User Experience
This language must be enabled to appear on the list. If the language is enabled, when a user opens the SAP Concur solutions Sign In page and then clicks to view the available languages list, Ukrainian appears in the list.
[image: ]
Configuration / Feature Activation
To enable this language, contact SAP Concur support.
[bookmark: _Toc107319762]Miscellaneous
[bookmark: _Toc107319763]**Ongoing** SAP Concur Migration to Cloud Platform in AWS

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	March 18, 2022
	Ongoing in 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319764]All Products | All Editions
Overview
SAP Concur plans to migrate from a pure private cloud operation, where all equipment is owned by SAP Concur, to a cloud platform. We plan to close our own private data centers in favor of a cloud platform implemented in Amazon Web Services (AWS). While this process started in 2017, we are focused on the final phase of the migration in 2022 for the North American and EMEA data centers.
Business Purpose / Client Benefit
This change provides a stronger security posture, improved performance and stability, and faster innovation for our clients.
End-User Experience During Migration
While a company is being migrated from an SAP Concur private data center to the cloud platform, their SAP Concur solutions might not be available to end users. 
If an end user tries to sign in to SAP Concur solutions during the migration process, they might not be able to sign in and they might receive the following message:
"SAP Concur solutions is undergoing scheduled maintenance. Please try again later"
[image: ]
If an end user is working in SAP Concur solutions when their company is migrated, they might be returned to the sign in page.
SAP plans to implement migrations on weekends and after business hours. 
Configuration / Feature Activation
This change will occur automatically.
For details, refer to the SAP Concur Cloud Platform Strategy FAQ.
[bookmark: _Toc107319765]Profile Settings
[bookmark: _Hlk101180469][bookmark: _Toc107319766]**Ongoing** Accessibility Improvements to My Profile – Personal Information Page

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 22, 2022
	June 10, 2022
	Q2 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319767]Travel, Expense | Professional & Standard
Overview
To make the My Profile – Personal Information page in Profile Settings more accessible to users, SAP Concur is making changes to the page. Implementation of the changes began with the April 2022 release and will continue over time.
With the June release, the following changes are being implemented on the My Profile – Personal Information page:
· In the TSA Secure Flight section, the link to www.tsa.gov will be changed to plain text to better support the use of screen readers.
· In the Email Addresses section, tags, labels, and captions will be added to better support the use of screen readers.
· In the Travel Preferences section, tags, labels, and captions will be added to better support the use of screen readers.
· Minor changes will be made to improve tabbing between page items, including resolving issues where the tab order was not logical and issues where some page items were skipped.
With the May release, the following changes were implemented in the Assistants and Travel Arrangers section of the My Profile – Personal Information page:
· Table headers were added to the display table.
· Tags, labels, and captions were added to support the user of screen readers.
· Minor changes were made to facilitate tabbing between elements.
With the April release, the following changes were implemented in the Credit Cards section of the My Profile – Personal Information page:
· Table headers were added to the display table.
· Tags and captions were implemented to support the use of screen readers.
· Minor changes were made to facilitate tabbing between elements.
Business Purpose / Client Benefit
SAP Concur is committed to making our products accessible to as many users as possible. With that goal in mind, we plan to make changes to the My Profile – Personal Information page that will improve the user experience for users who don’t use a mouse and for users who use screen readers.  
Configuration / Feature Activation
The changes are implemented automatically.
For more information about accessibility improvements, refer to Accessibility Updates.
[bookmark: _Toc107319768]**Ongoing** Changes to My Profile, Home Page, and Profile Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	June 10, 2022
	Ongoing beginning in April 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319769]Travel, Expense, Invoice, Request, Mobile | Professional & Standard
Overview
SAP Concur has implemented or plans to implement changes to several pages in the UI. The changes will be implemented over time beginning in April of 2022 and continuing throughout 2022. 
These changes reflect SAP's commitment to supporting gender diversity by enabling gender non-binary users to enter consistent information when making travel arrangements and entering information in SAP Concur solutions. Changes include but are not limited to the following:
April 2022 Release
· The greeting on the SAP Concur Home page was removed. In addition, first and last name were removed from the menu in the SAP Concur mobile app.
· If a user adds their preferred name on the My Profile – Personal Information page in Profile Settings, their preferred name and last name is displayed in the SAP Concur Profile menu.
May 2022 Release
· The Nickname field on the My Profile – Personal Information page was changed from Nickname to Preferred Name.
· The Nickname field in the Employee Travel Addendum Import 350 file was changed from Nick Name to Preferred Name.
· The Nickname field in the Employee Import file was changed from Nickname to Preferred Name.
June 2022 Release
· The Nickname field on the user details page in User Administration was changed from Nickname to Preferred Name.
Future Releases
· A new option, Mx, will be added to the Title list on the My Profile – Personal Information page.
· New options will be added to enable users to select a non-binary gender in the TSA Secure Flight section of Travel Preferences.
· New options will be added to the gender field in the Travel Profile 2.0 API. This change will enable callers, such as TMCs and App Center partners, to provision (write) and receive (read) the new non-binary gender values.
Business Purpose / Client Benefit
These changes:
· Enable users to enter information into SAP Concur solutions that is consistent with their identity.
· Enable SAP Concur solutions to address a user by their preferred name.
· Ensure that information in SAP Concur solutions matches a user's government-issued identification.
· Ensure that travel documents such as airplane tickets purchased through SAP Concur solutions display information that is consistent with other required documents.
[bookmark: _Toc107319770]Implemented and Planned Changes
SAP Concur has implemented or plans to implement the following changes overtime beginning in April 2022 and continuing throughout 2022. 
April 2022 Release
Web UI Page Header
[bookmark: _Hlk100142441]The greeting on the Concur home page, "Hello <First Name>" was removed in April. The greeting included the name from the First Name field in the end user's user account.
Previously
The greeting "Hello, <First Name>" was included on the SAP Concur homepage.
[image: ]
With the April 2022 Release
The greeting is no longer included.
[image: ]
Mobile App
Previously
Prior to the April 2022 release, the menu in the Mobile app included the first and last names from the respective fields in the user's user account.
[image: ]
With the April 2022 Release
With the April 2022 release, no name is included at the top of the Mobile app menu.
[image: ]
Web UI Profile Menu
Beginning with the April release, if a user specifies a preferred name on the Profile – Personal Information page in Profile Settings, when they click on Profile in the web version of SAP Concur solutions, their preferred name and last name is displayed. 
[image: ]
If the user has not specified a preferred name, their first and last names from their user account information will be displayed.
May 2022 Release
My Profile - Personal Information – Preferred Name
Preferred Name Field
Prior to the May 2022 release, a Nickname field was included on the My Profile – Personal Information page. With the May 2022 release, this field will be replaced by the Preferred Name field.
[image: ]
Preferred Name in Import and Extract Files
With the May 2022 release, the Nickname fields in import and extract files will be renamed to Preferred name.
Employee Travel Addendum Import 350
The Preferred Name field will replace the Nick Name field in Employee Travel Addendum Import 350.

[image: ]
User Import
The Preferred Name field will replace the Nickname field in User Import.
[image: ]
Import Data
The Preferred Name field will replace the Nickname field in the user general information template.
[image: ]
Previously downloaded templates containing the Nickname field will continue to be processed.
June 2022 Release
On the user detail pages in User Administration, in the General Settings section, the Nickname field will be changed from Nickname to Preferred Name.
[image: ]
Future Releases
Title List
In a future release, a new gender non-binary option, Mx (pronounced "Mix"), will be added to the list in the Title list.
Travel Preferences TSA Secure Flight
Currently, users see two options under Gender in the TSA Secure Flight section of Travel Preferences. 
[image: ]
In a future release, users will have two additional options under Gender: undisclosed (x) and unspecified (u). 
When selecting a gender option, users should choose the option that matches the government-issued ID they use when travelling.
Web UI Profile Menu
When users with permission to act on behalf of another user—for example, Travel Arrangers and Delegates—search for and act as another user, they will see the preferred name of the user they are acting on behalf of in the search field and at the top of the Profile menu.
[image: ]   [image: ] 
Configuration / Feature Activation
These changes will occur automatically over time. Users might need to update the information on the My Profile – Personal Information page after the changes are implemented. 
For more information, refer to the Preferred Name and Nonbinary Gender Options fact sheet.
[bookmark: _Toc107319771]Security
[bookmark: _Toc107319772]Some TLSv1.2 Ciphers No Longer Supported (Feb 1, 2022)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 13, 2021
	January 14, 2022
	February 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319773]Travel, Expense, Invoice, Request | All Editions
Overview
Beginning on February 1, 2022, SAP Concur solutions will no longer support connections to *.concursolutions.com and * api.concursolutions.com that use the following TLSv1.2 ciphers:
	Akamai/OpenSSL cipher name
	IANA cipher name

	AES256-GCM-SHA384
	TLS_RSA_WITH_AES_256_GCM_SHA384

	AES128-GCM-SHA256
	TLS_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384

	ECDHE-RSA-AES128-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

	ECDHE-RSA-AES256-SHA
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

	ECDHE-RSA-AES128-SHA
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA


To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, clients and partners who connect to *.concursolutions.com and *api.concursolutions.com through an application that uses a retired cipher must update the application to a supported cipher before February 1, 2022.
Business Purpose / Client Benefit
This update provides ongoing security for our products and services.
Confirming Supported Ciphers
The following ciphers included in the ak-akamai-2020q1 cipher profile are supported:

	Akamai/OpenSSL cipher name
	IANA cipher name

	TLS-AES-256-GCM-SHA384
	TLS_AES_256_GCM_SHA384

	TLS-CHACHA20-POLY1305-SHA256
	TLS_CHACHA20_POLY1305_SHA256

	TLS-AES-128-GCM-SHA256
	TLS_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-GCM-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

	ECDHE-RSA-AES128-GCM-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-CHACHA20-POLY1305
	TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305_SHA256


If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
You can confirm that your cipher suite includes a supported cipher by cross-referencing the Akamai/OpenSSL cipher name with the IANA cipher name in the ak-akamai-2021 (default) column in the following table. 
Supported ciphers are indicated with a check mark.
[image: ] 
Testing Ciphers
The following procedure is intended for use by system administrators who want to test whether their cipher suite configuration will work correctly when connecting to SAP Concur solutions after support for the ciphers listed above has been removed. 
This procedure configures the system admin's local machine to connect to an akamai staging environment where support for the listed ciphers has already been removed. 
Summary of the procedure:
· Retrieve the IP address of the akamai production environment.
· Retrieve the IP address of the akamai staging environment.
· Redirect navigation to concursolutions.com to the akamai staging environment by editing the local Hosts file.
· Test a connection to concursolutions.com.
Confirm Your Cipher Suite is Working Correctly
Retrieve the IP Address of the Akamai Production Environment
1. Ping www.concursolutions.com
Windows: Open a Command Prompt window, type “Ping www.concursolutions.com” and then press Enter.
Mac: Open Terminal, type “Ping www.concursolutions.com” and then press Enter.
Example response
Pinging e7868.b.akamaiedge.net (23.46.104.197): 56 data bytes
64 bytes from 23.46.104.197: icmp_seq=0 ttl=50 time=125.070 ms
64 bytes from 23.46.104.197: icmp_seq=1 ttl=50 time=111.866 ms
64 bytes from 23.46.104.197: icmp_seq=2 ttl=50 time=111.967 ms
64 bytes from 23.46.104.197: icmp_seq=3 ttl=50 time=112.435 ms
Copy the highlighted address in the response.
Example address
e7868.b.akamaiedge.net
Retrieve the IP address of the akamai staging environment
1. In the Command Prompt or Terminal window, ping the copied address, but with “-staging” appended to “akamaiedge”.
Example Ping command
Ping e7868.b.akamaiedge-staging.net
Example response
Pinging e7868.b.akamaiedge-staging.net (104.76.225.252): 56 data bytes
64 bytes from 104.76.225.252: icmp_seq=0 ttl=50 time=118.809 ms
64 bytes from 104.76.225.252: icmp_seq=1 ttl=50 time=242.459 ms
64 bytes from 104.76.225.252: icmp_seq=2 ttl=50 time=112.145 ms
64 bytes from 104.76.225.252: icmp_seq=3 ttl=50 time=114.994 ms
Copy the highlighted IP address in the response.
Example IP address
104.76.225.252
Update the Local Hosts File
MAC:
1) Open Terminal
2) Type “sudo nano /private/etc/hosts” and then press Enter.
[image: ]
If prompted, enter your administrator password.
3) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
4) Save the file (Ctrl-o) and close Terminal (Ctrl-x).
Windows:
Launch Notepad as administrator by typing “Notepad” into the Windows search bar, right-clicking Notepad in the search results, and then clicking Run as administrator.
[image: ]
If prompted, click Yes in the User Account Control window.
5) In Notepad, click File and then click Open.
6) Navigate to C:\\Windows\System32\drivers\etc and then, to the right of the File name field, choose All Files (*.*) from the menu.
[image: ]
7) Open the hosts file.
8) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
[image: ]
9) In the File menu, click Save.
Connect to *concursolutions.com from the Local Machine
After configuring your local hosts file to direct connections to *concursolutions.com to the akamai staging environment, connect to *concursolutions.com from the local machine through the method you need to test. 
Your system administrator might need to test connections to *concursolutions.com made via an API call, connected application, or by navigating to the sign-in page through a web browser and signing in as an SAP Concur user.
Configuration / Feature Activation
To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, any applications that use an unsupported cipher must be updated to use a supported cipher before February 1, 2022.
If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
[bookmark: _Toc107319774]Test Entities | Production Sandbox Environment
[bookmark: _Toc88647380][bookmark: _Hlk92986554][bookmark: _Toc107319775]PSE Data Maintenance and Entity Deletion

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 10, 2022
	--
	May 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319776]Expense, Invoice, Request, Intelligence | Professional
Overview
As part of SAP Concur routine data maintenance and operations, data in SAP Concur Production Sandbox Environments (PSEs) that is stagnant for more than 76 days is marked for deletion. After being marked for deletion, the PSE is held for 60 days before the deletion process is initiated. 
The deletion process consists of four statuses:
· Enabled: 
Entities that have been signed in to within the last 76 days are considered active and remain enabled.
· Pending Deletion: 
Entities that have not been signed in to for 76 days are moved to Pending Deletion status (marked for deletion) between 77 and 90 days after the last sign in. 
Entities are held in Pending Deletion status for 60 days. 
· Delete Initiated: 
Entities that have been in Pending Deletion status for 60 days are moved to Delete Initiated status and deletion of the entity begins. The deletion process is irreversible.
· Deleted: 
The PSE has been deleted and cannot be retrieved.
1. The deletion of data or entities in the production sandbox environment has no impact on live production entities.
Business Purpose / Client Benefit
This maintenance activity supports SAP and client data compliance requirements by minimizing the retention of personal data outside of the live production environment.
Configuration / Feature Activation
The deletion process for stagnant PSEs occurs automatically. 
For clients who use the product sandbox environment, SAP Concur support can assist clients with a normal refresh of their current production data in their PSEs. 

If you experience issues signing in to your PSE, contact SAP Concur support for assistance.
[bookmark: _Toc107319777]**Ongoing** Most Recently Used Lists Not Migrated

	Information First Published
	Information Last Modified
	Feature Target Release Date

	September 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319778]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Due to the architectural changes that SAP Concur must make to support this move, when PSEs are migrated to the new environment, some Most Recently Used (MRU) list items within the PSE will not be migrated.
MRU lists consist of recent selections made by the user. These lists are generated overtime as users interact with various menus and other defined lists and they will be regenerated after the PSE is migrated to the new environment.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs benefit from the same stability, monitoring capabilities, and level of performance as production entities.
End-User Experience
After the migration, some MRU lists that were generated prior to the migration will be empty. These lists will be regenerated automatically through the normal use of the PSE.
The following screenshots show some examples of MRU lists that will be impacted by the migration:
Create New Expense in Concur Expense
[image: ]
New Segment in Concur Request
[image: ]
Configuration / Feature Activation
This change occurs when a PSE is migrated to the new AWS environment; there are no configuration or activation steps. The MRU lists will be regenerated with normal user of the entity.
[bookmark: _Toc107319779]**Ongoing** Production Sandbox Environment Login Updates

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319780]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Today, a user can maintain the same login ID for their test and production entities because they are in separate environments. With the plan to migrate both test and production entities to the same AWS production environment in the future, this will no longer be possible since each login ID must be unique. 
While there is no action required for clients regarding this update, we want to ensure clients are aware of it because the change will be visible in certain areas of PSEs. To account for this change, SAP Concur will append all PSE login IDs with a ".uat” domain during both migration and user creation to ensure they are unique and do not conflict with any existing production login ID. For example, johnsmith@123.com will become johnsmith@123.com.uat.
IMPORTANT: No changes will made to the login IDs in the current implementation environment in our private data centers.

This process will occur in the background during both the migration and user creation processes. Because SAP Concur will manage this process, users will NOT have to make any changes to their login ID. 

Migrated users will still use the same implementation URL and login ID they used prior to the AWS migration. 

New clients will use the production URL with the appended login ID, which will include the appended domain (for example, johnsmith@123.com.uat). 
This change will help to safeguard against any conflicts with production login IDs. 
User Creation: Additionally, clients can use the exact same employee import files as they would in production. The uat domain will also be applied to all aspects of user creation: FTP import, Excel import, entity restore, and more.
Extracts: When generating accounting extracts or financial integration documents, SAP Concur will automatically remove the uat domain from login IDs that were appended during user creation. This will help to generate realistic extracts without requiring any actions from the clients, such as removing the appended domain.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc107319781]**Ongoing** Unique Address Required for PSE Email Verification

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2021
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319782]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
When PSEs are migrated to the AWS production environment, verified emails from the existing PSE will not carry over to the new PSE. As a result, when users test verified email functionality in a future PSE, it is recommended that the employee uses an email that is different from the email configured in their production entity. This process is required as the email in the existing PSE was most likely already verified in production and, therefore, cannot be verified in another entity.
With respect to user email addresses, the Receipt Recognition service validates user email addresses and as such, only one instance of an email address can be associated with a user account. To test in production, clients will be required to utilize alternate email addresses that are not currently associated with any production user account. If a client attempts to set up a test account in production using an email address already associated with a corresponding user profile, it will fail the validation process.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Admin Experience
BEFORE – Existing Email in Existing PSE
[image: Before screenshot of Existing Email in Existing Test Entity]
AFTER – New Email in New/Future PSE
[image: After screenshot of New Email in New/Future Test Entity]
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc107319783]SSO Management
[bookmark: _Toc107319784]New Checkbox to Hide SSO Sign-In Option

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	June 10, 2022
	June 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319785]Travel, Expense, Invoice, Request | Professional & Standard
Overview
With the June release, SAP Concur will add a checkbox to the Add IdP Metadata and Edit IdP Configuration dialogs. The checkbox enables an SSO administrator to prevent a specified SSO sign-in method from being presented to users as a sign-in option on the concursolutions.com sign-in page. 
In addition, SAP Concur will add a column to the table in the IdP Metadata section of the Manage Single Sign-On page to indicate whether the checkbox to hide the SSO sign-in option is enabled (checked) or disabled (unchecked) for each configured sign-in method. A column will also be added to the change history table to indicate whether the configuration of the option changed.
Users will still be able to sign-in via the method through other navigation paths as outlined by their company. 
Business Purpose / Client Benefit
The addition of this checkbox gives the SSO administrator greater control over how end-users sign in to their SAP Concur solutions.
SSO Admin Experience
When an SSO admin clicks Add or Edit in the IdP Metadata section, the new checkbox is available at the bottom of the Add IdP Metadata or the Edit IdP Configuration dialog.
[image: ]
When the admin navigates to the Manage Single Sign-On page, if SSO sign-in methods are configured, the new column indicates whether the method is available to end users or hidden from them. In addition, if the admin clicks View Previous Changes, a column that tracks changes to the checkbox appears in the View Previous Changes table.
[image: ]
The SSO sign-in option can be enabled (checked) and disabled (unchecked) in the Edit IdP Configuration dialog.
Configuration / Feature Activation
These changes occur automatically; there are no configuration or activation steps.
[bookmark: _Toc107319786]Option to Provide URL to IdP Metadata to be Removed

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	June 10, 2022
	June 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319787]Travel, Expense, Invoice, Request | Professional & Standard
Overview
With the June release, SAP Concur plans to remove the Provide link to your IdP's metadata field from the Add IdP Metadata dialog.
Business Purpose / Client Benefit
To use the Provide link to your IdP's metadata field, clients must first open a support ticket to have the URL added to the SAP Concur allow list. These additional steps do not support the goal of making the SSO management process self-service for our clients.
SSO Admin Experience
When the SSO admin navigates to the Manage Single Sign-On page and then clicks Add in the IdP Metadata section, they no longer see the Provide link to your IdP's metadata field in the Add IdP Metadata dialog.
The admin will still be able to upload IdP metadata by clicking Upload XML File.
Before
[image: ]
After
[image: ]
Configuration / Feature Activation
The field will be removed from the Add IdP Metadata page automatically.
[bookmark: _Toc107319788]User Assistance for Admins and End Users
[bookmark: _Toc107319789]New Tours Added to User Assistance for Admins and End Users (US, EMEA)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 10, 2022
	June 17, 2022
	June 18, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319790]Travel, Expense, Request, TripLink | Professional & Standard
The SAP Concur June release includes new User Assistance content (tours). The new tours expand the scope of information provided by User Assistance for Admins and End Users.
The following new tours are included in the June release:
· Concur Travel (Legacy)
Book a Rail Ticket
End of booking reminder
· Concur Travel (Evolution of Travel/T2)
Book a Rail Ticket (Renfe)
· Concur Expense
Adding Car Mileage to an Expense Report (Mileage Service)
· Concur Request Integrated with Concur Expense
Adding Expected Car Mileage to a Request (Mileage Service)
· Concur Request Integrated with Concur Travel
Book then Approve
· Concur TripLink
Connect to Travel Partner Integrations
Connect to TripIt Pro
Remove a personal trip
Remove a personal segment of a trip
· User Assistant
Introduction to the Concur User Assistant
Business Purpose / Client Benefit
User Assistance for Admins and End Users assists admins and users to learn new tasks more quickly and efficiently by providing guided tours with step-by-step instructions for completing a task. Enabling users to learn and complete tasks more easily drives user adoption, increases efficiency, improves user experience, and improves user satisfaction with SAP Concur solutions.
Configuration / Feature Activation
The new tours are automatically available on entities where User Assistance for Admins and End Users is enabled.
For more information about User Assistance for Admins and End Users, including steps for enabling and configuring User Assistance for Admins and End Users, refer to the User Assistance for Admins and End Users fact sheet.
[bookmark: _Toc107319791]Planned Changes
[bookmark: _Hlk92890624]The following features and changes are targeted for future releases. SAP Concur solutions reserves the right to postpone implementation of – or completely remove – any enhancement/change mentioned here. 
[bookmark: _Toc46229145][bookmark: _Hlk523311325][bookmark: _Toc478727899][bookmark: _Toc107319792]Fax Feature
[bookmark: _Toc107319793]**Planned Changes** Fax Feature to be Decommissioned

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 2021
	January 14, 2022
	October 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319794]Expense, Invoice | Professional & Standard
Overview
On October 1, 2022, the Concur Fax Feature will be decommissioned.
[bookmark: _Hlk86919337]The Fax feature was retired in 2020. Clients onboarded after July 15, 2020 do not have access to this feature. Among clients with access, very few use the feature regularly and, among those that use it, use has declined steadily.
Business Purpose / Client Benefit
Removal of the Fax feature improves the security, performance, and scalability of SAP Concur solutions. 
In addition, The Concur Fax Feature attaches files only at the header level of expenses and invoices. As a result, clients who use the Fax Feature cannot take advantage of recent innovations that apply only to images and attachments at the line-item level.
End-User Experience
Users will no longer have the option to print Fax cover pages from within Concur Expense or Concur Invoice and they will no longer have the ability to fax images to SAP Concur for attachment to expenses or invoices.
Configuration / Feature Activation
This change occurs automatically; there are no configuration steps. Additional information about this change will be made available over the coming months.
[bookmark: _Toc79737887][bookmark: _Toc107319795]File Transfer Updates
[bookmark: _Toc107319796]**Planned Changes** New File Transfer Endpoints After Migration to AWS

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 10, 2022
	June 17, 2022
	Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319797]All Products | Professional & Standard
Overview
With the SAP Concur migration to Cloud Platform in AWS, new endpoints will be implemented for file transfers. After your entity is migrated to the new platform, you will receive notification about the migration including the new endpoints. After you receive notification, you will have 30 days to switch from the old endpoint(s) to the new AWS Transfer endpoint(s).
IMPORTANT! Do not switch endpoints until you have been notified. Doing so will have unpredictable results.
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
Business Purpose / Client Benefit
The SAP Concur migration to Cloud Platform in AWS provides a stronger security posture, improved performance and stability, and faster innovation for our clients.
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Configuration / Feature Activation
After you receive notification that your entity has been migrated to AWS, you will have 30 days to update your systems to point to the new AWS Transfer endpoints.
IMPORTANT! Do not switch endpoints until you have been notified. Doing so will have unpredictable results.
[bookmark: _Toc107319798]Financial Integration
[bookmark: _Toc107319799]**Planned Changes** Sage Accounting to be Retired

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 15, 2022
	--
	July 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319800]Expense, Invoice | Standard Edition
Overview
In July 2022, SAP Concur solutions plans to retire the Sage Accounting integration with Concur Expense and Concur Invoice.
This change does not impact the Sage Intacct integration.
Business Purpose / Client Benefit
This integration offering has not been adopted by any SAP Concur clients.
Configuration / Feature Activation
This retirement will occur automatically.
[bookmark: _Toc107319801]Help Menu
[bookmark: _Hlk96071113][bookmark: _Toc107319802]**Planned Change** Consolidation of Resources Under Help Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	May 13, 2022
	June 30, 2022 and Future release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319803]All Products | All Editions
Overview
In June 2022, SAP plans to begin consolidating SAP Concur help resources under the Help menu in SAP Concur solutions. These changes will occur in two phases:
· Phase 1 -Targeted for June 30, 2022: In addition to the help content that is currently available from the Help menu, SAP Enable Now will be accessed from the Help menu.
For more information about support for SAP Enable Now, refer to the **Planned Changes** Support for SAP Enable Now release note in this document.
· Phase 2 – Targeted for a future release: The question mark icon (?) that currently provides access to user assistance, video tutorials, and tools for contacting support will be removed and those items will be accessed from the consolidated Help menu.
For more information about user assistance for admins and end users, refer to the User Assistance for Admins and End Users fact sheet.
Business Purpose / Client Benefit
These changes will improve ease of use and simplify the SAP Concur user interface by providing a single point of access to help resources.
User Experience
When all changes have been implemented, new options will be available in the Help menu—for example, if User Assistance for End Users or SAP Enable Now are enabled, a link to access those resources will appear in the Help menu.
Configuration / Feature Activation
These changes will be implemented automatically.
[bookmark: _Toc107319804]User Administration
[bookmark: _Toc107319805]**Planned Changes** Standalone White Spaces No Longer Valid in User Account Name Fields

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 17, 2022
	--
	Phased beginning in July

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319806]Travel, Expense, Invoice, Request | Professional & Standard
Overview
SAP Concur plans to apply validation that prevents the use of standalone white space characters in name fields in user accounts. This validation will be implemented in phases, beginning in mid-to-late July 2022.
Planned changes include the following:
· Standalone white space characters will no longer be accepted as a valid entry in name fields in user accounts.
White space characters that are part of a valid name will be accepted.
· If a name field is populated with only white space characters via the API, the employee import file, or manual entry, a message or error will be returned and the entries will not be accepted. 
The type of response received when entering an invalid name depends on the method of entry.
Business Purpose / Client Benefit
Ensuring that valid names are entered into the name fields in SAP Concur solutions can prevent errors when the data is exported to external systems that do not support or cannot process standalone white space characters in name fields.
Admin Experience
If an admin attempts to enter only white spaces in a name field on the User Details page, through an API call, or through the employee import process, the entry or entries will not be accepted and a message or error will be returned.
White space characters that are part of a valid name—for example, "Mary Ann"—are valid and will continue to be accepted. 
Configuration / Feature Activation
This validation will be added automatically.
[bookmark: _Toc107319807]User Assistance
[bookmark: _Toc107319808]**Planned Changes** Support for SAP Enable Now

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	May 13, 2022
	June 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319809]Travel, Expense, Invoice, Request | Professional & Standard
Overview
In late June, SAP plans to add support for SAP Enable Now with SAP Concur solutions. 
Business Purpose / Client Benefit
This change will enable clients to use SAP Enable Now to create user assistance content to improve user adoption and increase efficiency with SAP Concur solutions.
Configuration / Feature Activation
After support for SAP Enable Now has been added to SAP Concur solutions, clients who have User Assistance enabled for their SAP Concur solutions will be able to enable and disable SAP Enable Now on the SAP Concur User Assistance page.
More detailed information about this feature will be included in a future release note.
[bookmark: _Toc107319810]User Export and Import
[bookmark: _Toc107319811]**Planned Changes** User Export and Import Improvements

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 22, 2022
	--
	Q3 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc107319812]Expense, Invoice, Request | Standard Edition
Overview
SAP Concur plans to implement improvements to the user export/import experience. Improvements include, but are not limited to:
· Improvements to the downloadable user data template including tooltips and dropdown lists
· Removal of the 1000 user maximum for imports and exports of user data
· The addition of a new Manage Users via a Spreadsheet page
Business Purpose / Client Benefit
These improvements increase the ease of use and experience of the user import and export processes.
Admin Experience
On the Users page in Product Settings, when the admin clicks Add Users > From Spreadsheet, the admin sees the new Manage Users via a Spreadsheet page.
[image: ]
[image: ]
On the Manage Users via a Spreadsheet page, the admin can export, update, and import user data. When they export the spreadsheet, they will see new tooltips and, where applicable, dropdown lists in the spreadsheet. In addition, they will no longer be limited to downloading 1000 rows of user data.
Initial Release Opt-In Phase and Survey
During the initial release phase, clients will be able to opt-in to the new experience and will have the option to provide feedback on the experience through a survey. 
Configuration / Feature Activation
This new user export/import experience will be automatically available. During the initial release phase, clients will be able to opt-in to the new experience.
[bookmark: _Toc510082427][bookmark: _Toc12880017][bookmark: _Toc46229154][bookmark: _Toc11147478][bookmark: _Toc107319813]Client Notifications
[bookmark: _Toc69211924][bookmark: _Toc480899347][bookmark: _Toc483562026][bookmark: _Toc484092107][bookmark: _Toc480899345][bookmark: _Toc483562024][bookmark: _Toc484092109][bookmark: _Toc510082430][bookmark: _Toc514338227][bookmark: _Toc12880020][bookmark: _Toc46229157][bookmark: _Toc107319814]Accessibility
[bookmark: _Toc69211925][bookmark: _Toc107319815]Accessibility Enhancements
SAP implements changes to better meet current Web Content Accessibility Guidelines (WCAG). Information about accessibility-related changes made to SAP Concur solutions is published on a quarterly basis. You can review the quarterly updates on the Accessibility Updates (English Only) page.
[bookmark: _Toc107319816]Subprocessors
[bookmark: _Toc480899346][bookmark: _Toc483562025][bookmark: _Toc484092110][bookmark: _Toc510082431][bookmark: _Toc514338228][bookmark: _Toc69118207][bookmark: _Toc107319817]SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors / Data Transfer Factsheets page.

To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
Sign in to the SAP Support Portal using your Support User ID (S-user) and password.
SAP customers must sign in to the SAP Support Portal using their Support User ID (S-user) and password. For information about S-User IDs, refer to Your New Support User ID (S-user). 
On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in the Search field.
In the Title column, click SAP Concur Sub-processors List.
If you have questions or comments, please reach out to: Privacy-Request@Concur.com 

[bookmark: _Toc77840903][bookmark: _Toc107319818]Supported Browsers
[bookmark: _Toc77840904][bookmark: _Toc107319819]Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will also appear in the Shared Planned Changes release notes.
[bookmark: _Toc90037239][bookmark: _Toc107319820]Additional Release Notes and Other Technical Documentation
[bookmark: _Toc90037240][bookmark: _Toc107319821]Online Help
Any user can access release notes, setup guides, user guides, admin summaries, monthly browser certifications, supported configurations, and other resources via online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product (Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP Help Portal (https://help.sap.com) to view the full set of documentation for your product.
[bookmark: _Toc90037241][bookmark: _Toc107319822][bookmark: _Toc530557893]SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu. Click to access the SAP Concur support portal, then click Resources. 
Click Release/Tech Info for release notes, technical documents, etc. 
Click Webinars for recorded and live webinars.
[image: P1891#yIS1]
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Travel Addendum Import (Record Type 350) Format

The 350-level record is used with either the 305-level (Expense & Travel user) or the 310-level (Travel only user) record block, or the user must already exist in the Expense database / system.

! The 350 record import functionality is not available if the Email login option is used.

Table 6: Data for record ID "TravelAddendumImport”

1 Transaction Type 350 Y. This is a static numeric value always equal to 350. It indicates the Record Type

2 Employee ID 48 characters maximum Y. Must match a 305-level record in this file

3 Name Prefix 60 characters maximum N Must contain these exact values (Lord, Lady, Sir, Mr, Miss, Ms, Mrs, Dr, Rev, Prof)
4 Name Suffix 60 characters maximum N Must contain these exact values (Jr., Sr., I, II, III, IV, V, VI)

5 Nick Name 60 characters maximum N Informal, non-birth name employee is known as.
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'user's birthday in M/D/YYYY format.
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# Additionally, comments (such as these) may be inserted on individual
#lines or following the machine name denoted by a # symbol.

#

# For example:

#

# 102549497  rhino.acme.com # source server

# 38256310 xacme.com #x client host

# localhost name resolution is handled within DNS itself.
# 127001 localhost
# A localhost

104.76.225 252 www concursolutions.com
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